
PDF generated using the open source mwlib toolkit. See http://code.pediapress.com/ for more information.
PDF generated at: Sat, 24 Jul 2010 02:33:12 UTC

Essentials of Photoshop



Contents
Articles

Adobe Photoshop 1
Adobe Photoshop Lightroom Preset 9
Filter Forge 10
Harry's Filters 11
IconBuilder 12
National Association of Photoshop Professionals 13
SVG Kit for Adobe Creative Suite 14

References
Article Sources and Contributors 16
Image Sources, Licenses and Contributors 17

Article Licenses
License 18



Adobe Photoshop 1

Adobe Photoshop

Adobe Photoshop CS5 x64 running on Windows 7 x64
Developer(s) Adobe Systems

Stable release  CS5 (12.0.1) / June 30, 2010

Written in C++

Platform Mac OS X, Microsoft Windows

Available in 27 languages

Type Raster graphics editor

License Proprietary software [1]

Website adobe.com/photoshop [2]

Adobe Photoshop is a graphics editing program developed and published by Adobe Systems.
Adobe's 2003 "Creative Suite" rebranding led to Adobe Photoshop 8's renaming to Adobe Photoshop CS. Thus,
Adobe Photoshop CS5 is the 12th major release of Adobe Photoshop. The CS rebranding also resulted in Adobe
offering numerous software packages containing multiple Adobe programs for a reduced price. There are two
versions of Photoshop: Basic and Extended, with Extended having extra features available. Adobe Photoshop
Extended is included in all of Adobe's Creative Suite offerings but Design Standard, which has the Basic version.

Development

Early history
In 1987, Thomas Knoll, a PhD student at the University of Michigan, began writing a program on his Macintosh
Plus to display grayscale images on a monochrome display. This program, called Display, caught the attention of his
brother John Knoll, an Industrial Light & Magic employee, who recommended Thomas turn it into a full-fledged
image editing program. Thomas took a six month break from his studies in 1988 to collaborate with his brother on
the program, which had been renamed ImagePro.[3] Later that year, Thomas renamed his program Photoshop and
worked out a short-term deal with scanner manufacturer Barneyscan to distribute copies of the program with a slide
scanner; a "total of about 200 copies of Photoshop were shipped" this way.[4]

During this time, John traveled to Silicon Valley and gave a demonstration of the program to engineers at Apple and
Russell Brown, art director at Adobe. Both showings were successful, and Adobe decided to purchase the license to
distribute in September 1988.[3] While John worked on plug-ins in California, Thomas remained in Ann Arbor
writing program code. Photoshop 1.0 was released in 1990 for Macintosh exclusively.[5]
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Features
Photoshop has ties with other Adobe software for media editing, animation, and authoring. The .PSD (Photoshop
Document), Photoshop's native format, stores an image with support for most imaging options available in
Photoshop. These include layers with masks, color spaces, ICC profiles, transparency, text, alpha channels and spot
colors, clipping paths, and duotone settings. This is in contrast to many other file formats (e.g. .EPS or .GIF) that
restrict content to provide streamlined, predictable functionality.
Photoshop's popularity means that the .PSD format is widely used, and it is supported to some extent by most
competing software. The .PSD file format can be exported to and from Adobe Illustrator, Adobe Premiere Pro, and
After Effects, to make professional standard DVDs and provide non-linear editing and special effects services, such
as backgrounds, textures, and so on, for television, film, and the Web. Photoshop is a pixel-based image editor,
unlike programs such as Macromedia FreeHand (now defunct), Adobe Illustrator, Inkscape or CorelDraw, which are
vector-based image editors.
Photoshop uses color models RGB, lab, CMYK, grayscale, binary bitmap, and duotone. Photoshop has the ability to
read and write raster and vector image formats such as .EPS, .PNG, .GIF, .JPEG, and Adobe Fireworks.

CS3

Smart Layers display the filter without altering
the original image (here on Mac OS X)

New features propagating productivity include streamlined interface,
improved Camera Raw, better control over print options, enhanced
PDF support, and better management with Adobe Bridge. Editing tools
new to CS3 are the Clone Source palette and nondestructive Smart
Filters, and other features such as the brightness and contrast
adjustment and Vanishing Point module were enhanced. The Black and
White adjustment option improves control over manual grayscale
conversions with a dialog box similar to that of Channel Mixer.
Compositing is assisted with Photoshop's new Quick Selection and
Refine Edge tools and improved image stitching technology.[6]

CS3 Extended contains all features of CS3 plus tools for editing and
importing some 3D graphics file formats, enhancing video, and
comprehensive image analysis tools, utilizing MATLAB integration
and DICOM file support.[7]

CS4
Photoshop CS4 features a new 3D engine allowing painting directly on 3D models, wrapping 2D images around 3D
shapes, converting gradient maps to 3D objects, adding depth to layers and text, getting print-quality output with the
new ray-tracing rendering engine. It supports common 3D formats; the new Adjustment and Mask Panels;
Content-aware scaling (seam carving[8] ); Fluid Canvas Rotation and File display options.[9] On 30 April, Adobe
released Photoshop CS4 Extended, which includes all the same features of Adobe Photoshop CS4 with the addition
of capabilities for scientific imaging, 3D, and high end film and video users. The successor to Photoshop CS3,
Photoshop CS4 is the first 64-bit Photoshop on consumer computers (only on Windows – the OS X version is still
32-bit only.)[10]
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CS5
Photoshop CS5 was launched on April 12, 2010.[11] In a video posted on its official Facebook page, the development
team revealed the new technologies under development, including three dimensional brushes and warping tools.[12]

A version of Adobe Photoshop CS5 Extended was used for a Prerelease Beta. A large group of selected Photoshop
users were invited to beta test in Mid-February of 2010.

Version history

Adobe Photoshop CS Adobe Photoshop CS2

Adobe Photoshop CS3 Extended

Version Platform Codename Release date Significant changes

0.63 Macintosh October 1988

1.0 Macintosh February 1990

2.0 Macintosh Fast Eddy June 1991 • Paths
• CMYK Color
• EPS Rasterization

2.5 Macintosh Merlin November
1992

• 16 bit per channel support

Windows Brimstone

IRIX, Solaris November
1993
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3.0 Macintosh Tiger
Mountain

September
1994

• Tabbed Palettes
• Layers

Windows, IRIX, Solaris [13] November
1994

4.0 Macintosh, Windows Big Electric
Cat

November
1996

• Adjustment Layers
• Actions (macros)
• Multiple Undo (Amount set in preferences)

5.0 Macintosh, Windows Strange
Cargo

May 1998 • Editable type (previously, type was rasterized as soon
as it was added)

• History Palette with History Brush (Enhanced undo)
• Color Management
• Magnetic Lasso

5.5 Macintosh, Windows Strange
Cargo

February 1999 • Bundled with ImageReady
• Save for Web
• Extract

6.0 Macintosh, Windows Venus in
Furs

September
2000

• Vector Shapes
• Updated User Interface
• "Liquify" filter
• Layer styles/Blending Options dialog

7.0 Mac OS 'Classic'/Mac OS X,
Windows

Liquid Sky March 2002 • Made text fully vector
• Healing Brush
• New painting engine

7.0.1 Mac OS 'Classic'/Mac OS X,
Windows

August 2002 • Camera RAW 1.x (optional plugin)

CS (8.0) Mac OS X, Windows Dark Matter October 2003 • Camera RAW 2.x
• Highly modified "Slice Tool"
• Shadow/Highlight command
• Match Color command
• Lens Blur filter
• Smart Guides
• Real-Time Histogram
• Detection and refusal to print scanned images of

various banknotes[14]

• Macrovision copy protection based on Safecast DRM
technology

• Scripting support for JavaScript and other languages
• Hierarchical layer groups
• 16 bit per channel layers, painting, and adjustments
• Support for files over 2 Gigabytes
• Documents up to 300,000 pixels in either dimension
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CS2 (9.0) Mac OS X, Windows 2000 / XP Space
Monkey

April 2005 • Camera RAW 3.x
• Smart Objects
• Image Warp
• Spot healing brush
• Red-Eye tool
• Lens Correction filter
• Smart Sharpen
• Smart Guides
• Vanishing Point
• Better memory management on 64-bit PowerPC G5

Macintosh machines running Mac OS X 10.4
• High dynamic range imaging (HDRI) support (32 bit

per channel floating point)
• More smudging options, such as "Scattering"
• Modified layer selection, such as ability to select

more than one layer.

CS3, CS3
Extended (10.0)

Universal Mac OS X, Windows XP
SP2 or later

Red Pill April 16, 2007 • Native support for the Intel-based Macintosh
platform and improved support for Windows Vista

• Revised user interface
• Feature additions to Adobe Camera RAW
• Quick Select tool
• Alterations to Curves, Vanishing Point, Channel

Mixer, Brightness and Contrast, and the Print dialog
• Black-and-white conversion adjustment
• Auto Align and Auto Blend
• Smart (non-destructive) Filters
• Mobile device graphic optimization
• Improvements to cloning and healing
• More complete 32 bit / HDR support (layers,

painting, more filters and adjustments)
• Faster launching

CS4, CS4
Extended (11.0)

Universal Mac OS X, Windows
xp-sp2(sp3 recommended), Vista,7

Stonehenge October 15,
2008[15]

• Smoother panning and zooming and fluid canvas
rotation

• OpenGL display acceleration in Photoshop
• Native support for 64-bit on Windows Vista x64
• Adjustments panel
• Auto-blending of images
• Masks panel
• Improved Adobe Photoshop Lightroom workflow
• Content-aware scaling
• Better raw image processing
• Extended depth of field
• Dramatically enhanced color correction
• Auto-alignment of layers
• New file display options (tabbed document display

and n-up views)
• New file management and workspaces with Adobe

Bridge CS4
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CS5, CS5
Extended (12.0)

Mac OS X v10, Windows
XP-SP3,Vista,7

White Rabbit April 30,
2010[16]

• Content Aware Fill
• Puppet Warp Tool
• 64 bit for Macintosh
• Bristle Tips
• Mixer Brush
• Automatic Lens Correction
• Improved Camera RAW processing
• Camera RAW grain control
• Improved Ray Tracing (Extended)
• Repousse 3D extrusion tool (Extended)
• Image based lights (Extended)

Release history

Version Platforms Code name Release date Notable features

1.0 Mac OS February 1990 • Color correction with Balance, Hue, and Saturation
• Image optimization for output
• Curves
• Levels
• Clone tool

2.0 Mac OS Fast Eddy June 1991 • Paths
• Rasterizer for Adobe Illustrator® files
• Support for CMYK color
• Duotones
• Pen tool

2.5 Mac OS, Windows, IRIX and
Solaris

1993 • Palettes
• Support for 16-bit files

3.0 Mac OS, Windows, IRIX and
Solaris

Tiger
Mountain

September 1994 • Layers
• Tabbed Palettes

5.0 Mac OS, Windows Strange Cargo May 1998 • International Color Consortium (ICC)-based color
workflows

• Multiple Undo (History Palette)
• Magnetic Lasso
• Editable Type

5.5 Mac OS, Windows February 1999 • ImageReady bundled with Photoshop
• Save for Web
• Extract
• Image slicing and rollover effects

6.0 Mac OS, Windows Venus in Furs September 2000 • Vector Shapes
• Updated user interface
• Liquify filter
• Layer styles/Blending Options dialog

7.0 Mac OS, Windows Liquid Sky March 2002 • Healing Brush
• Made text fully vector
• New painting engine
• Photoshop file browser

CS (8.0) Mac OS, Windows Dark Matter October 2003 • Shadow/Highlight command
• Match Color command
• Lens Blur filter
• Real-Time Histogram
• Highly modified Slice tool
• Hierarchical Layer groups



Adobe Photoshop 7

CS2 (9.0) Mac OS, Windows Space Monkey April 2005 • Adobe Bridge 1.0
• Smart Objects
• Image Warp
• Spot Healing brush
• Red-Eye tool
• Lens Correction filter
• Smart Sharpen
• Vanishing Point
• Smart Guides
• HDR imaging support

CS3
(10.0)

Mac OS, Windows Red Pill April 2007 Two versions: Basic and Extended

Basic:

• Smart Filters
• Native Intel Macintosh support
• Quick Selection tool
• Refine Edge tool
• Automatic layer alignment and blending

Extended:

• 3D visualization and texture editing
• MATLAB integration
• Measurement and counting tools
• DICOM format support
• Motion graphics and video layers
• Movie Paint
• Vanishing Point with 3D support
• Image stack processing

Express Internet March 27, 2008

CS4
(11.0)

Mac OS, Windows Stonehenge September 23,
2008

Two versions: Basic and Extended

Basic:

• Adjustments panel
• Masks panel
• Smoother panning and zooming
• Fluid canvas rotation
• Common user interface
• Content Aware Scaling

Extended:

• Breakthrough 3D editing and compositing
• Enhanced motion graphics
• Volume Rendering
• Easier data collection and analysis

CS5
(12.0)

Mac OS, Windows White Rabbit May 25, 2010
(sale)

Two versions: Basic and Extended

Basic:

• Complex selections made easy
• Content-Aware Fill
• HDR Pro and HDR Toning
• Puppet Warp
• Mixer Brush and Bristle Tips

Extended:

• Easy 3D extrusions with Adobe Repoussé
• Quick shadow creation and image-based lights
• Rich 3D materials library
• Motion-based content editing
• Image analysis and measurement
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Language availabilities
Photoshop is available in the following languages:
Brazilian Portuguese, Chinese Simplified, Chinese Traditional, Czech, Danish, Dutch, English, Finnish, French,
German, Hungarian, Italian, Japanese, Korean, Norwegian, Polish, Romanian, Russian, Spanish, Swedish, Turkish
and Ukrainian.[17]

The Arabic, Greek, Hebrew, Middle Eastern, and North African language versions are available from Winsoft.[17]

Plugins
Photoshop functionality can be extended by add-on programs called Photoshop plugins which act like mini-editors
that modify the image. The most common type are filter plugins that provide various image effects. They are located
in the 'Filter' menu. Photoshop plugin API has become a standard, and many other image editors also support
Photoshop Plugins.
Adobe Camera Raw (also known as ACR and Camera Raw) is a special plugin, supplied free by Adobe, used
primarily to read and process raw image files so that the resultant images can be processed by Photoshop.[18] It is
invoked by attempting to open such a file, rather than from the 'Filter' menu, but like other plugins is listed in the
'Help > About Plug-In' menu (as "Camera Raw"). It can also be opened via the Adobe Bridge by clicking on any
image and selecting 'File > Open in Adobe Camera Raw'.

Cultural impact
Photoshop and derivatives such as Photoshopped, Shopped, and Shooped are sometimes used [19] , but such
derivatives are discouraged by Adobe [20] because they constitute abuse of Adobe's registered trademark.
Shooped is originally thought to have come from 4chan where it was used for 'shoop posts' and a common meme
called "shoop da whoop". It has grown to mean any altering of a photo and has caused spin off websites to regularly
use it such as 4chan; 'The Pit' in Ultimate-guitar and sites such as shooped.org.

See also
• Adobe Photoshop Express
• Adobe Photoshop Elements
• Adobe Photoshop Lightroom
• Photoshop contest
• Image editing
• Comparison of raster graphics editors

External links
• Official website [21]

• Photoshop [22] at the Open Directory Project
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Presets are a fast way of performing a group of functions or effects on a photograph automatically. Workflow can be
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other photographers to use, it is also possible to import presets that other users have created to gain a specific effect.
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Filter Forge
Filter Forge is a standalone application and plugin for Adobe Photoshop and compatible 8bf plugin hosts that allows
users to apply programmable image processing filters and to define them with a visual node-based filter editor. A
similar approach is practiced in such applications as Genetica [1] and DarkTree [2]; Filter Forge's salient
characteristics include floating point processing, antialiasing, and support for producing bump maps and normal
maps (in addition to textures). Filter usage relies on a simple, non-customizable UI with a list of presets and the input
controls (sliders, lists, colour pickers...) that have been included in the filter dataflow.
The repertoire of nodes is fairly standard, with unusually rich support for curves, remapping scalar values and for
mapping images to parameters (with antialiasing); the lack of arbitrary formulas makes certain kinds of filters more
(sometimes significantly) difficult to implement. There is no support for modules, macros, or any other kind of node
grouping, which leaves copying and pasting nodes along with their connections as the only option to manage
complex filters.

A filter is opened in Filter Editor

Another unusual feature of Filter Forge is the web-based filter library
[3] of thousands of user-submitted filters (which are concise XML
documents) that can be opened with the program and previewed with a
built-in browser.

External links

• Filter Forge homepage [4]

• Filter Forge tutorial at The Photoshop Roadmap [5]

References
[1] http:/ / www. spiralgraphics. biz/ genetica. htm
[2] http:/ / www. darksim. com/ html/ dt25_description. html
[3] http:/ / www. filterforge. com/ filters/
[4] http:/ / www. filterforge. com
[5] http:/ / www. photoshoproadmap. com/ Photoshop-blog/ 2006/ 08/ 30/ creating-a-wet-and-muddy-rocks-texture/
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Harry's Filters
Harry's Filters is a plugin for Adobe Photoshop, which includes a set of 69 different image effects. There are 9
main effect categories including, among others, warp, pattern or color effects.[1] Each main category then contains a
series of parameters to fine tune the effect.[2]

The plugin also features a "jump" button, which selects a random effect and applies it to the picture.[2] It serves
mainly to quickly experiment with the various effects. Each effect configuration can be saved and reused later on.[1]

References
[1] Harry's Filters 3.0: 69 Free Image Effects (http:/ / graphicssoft. about. com/ b/ 2004/ 02/ 18/ harrys-filters-30-69-free-image-effects. htm)
[2] http:/ / www. extremetech. com/ article2/ 0,2845,1981070,00. asp
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IconBuilder 12

IconBuilder

Developer(s) The Iconfactory

Stable release  8.5.1 / 2007

Operating
system

Mac OS X, Windows 98, 2000, NT, ME or XP

Platform Photoshop, Elements or Fireworks

Type icon editor plugin

License Commercial, $79

Website [1]

IconBuilder is a popular[2] plugin for Adobe Photoshop, Adobe Photoshop Elements and Macromedia Fireworks for
the editing and creation of computer icons created and used by The Iconfactory. It supports all icon sizes for both
Mac OS X and Microsoft Windows. IconBuilder was created when there was no official tool from Apple Computer
for making icons in the .icns format introduced by Mac OS 8.5.
The Windows version is at version 2.0, lagging far behind the Macintosh version. The Mac OS 9 version is frozen at
3.1. Version 8 adds support for Windows Vista's 256×256 icons.
Alternatives are Folder Icon Maker X and Viou.[2]

Features
• Create icons of any size, up to 1,024×1,024 pixels.
• Supports Mac OS X icon drop state.
• Export to multiple file formats simultaneously.
• Import existing icons.
• File integrity checks.

See also
• Icon editor
• Favicon

References
[1] http:/ / iconfactory. com/ software/ iconbuilder
[2] Larry Ullman, Marc Liyanage, Mac OS X Panther timesaving techniques for dummies, For Dummies, 2004, ISBN 0764558129, p. 127 (http:/

/ books. google. com/ books?id=P8mvCz-NOvcC& pg=PA127& dq=photoshop+ iconbuilder& cd=9#v=onepage& q=photoshop iconbuilder&
f=false)

• Leslie Ayers (7 June 2007) How to Make Your Own Icon (http:/ / www. maclife. com/ article/ 

how_to_make_your_own_icon), Mac Life, also appeared in print Mac How-To, Spring 2007, p. 86 (http:/ / 

books. google. com/ books?id=2gIAAAAAMBAJ& pg=PT87& dq="iconbuilder"+ photoshop& num=50&
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client=safari& cd=2#v=onepage& q="iconbuilder" photoshop& f=false)
• Steve Caplin (May 2003) IconBuilder Pro 4.0 (http:/ / www. macuser. co. uk/ reviews/ 41707/ iconbuilder-pro-40.

html?searchString=iconbuilder), MacUser Product Reviews

External links
• IconBuilder website (http:/ / iconfactory. com/ software/ iconbuilder)
• Ko Maruyama (5 Oct 2005) IconBuilder 8 The IconFactory lets you take a closer look at art (http:/ / creativemac.

digitalmedianet. com/ articles/ viewarticle. jsp?id=35010-0), Digital Media Online

National Association of Photoshop Professionals
The National Association of Photoshop Professionals is an organization founded by Scott Kelby and has more
than 75,000+ members worldwide.

Photoshop User Magazine
The NAPP organisation produces the Photoshop User Magazine which is the organisation magazine where members
can each time read the latest happenings as well as several columns by trainers on Photoshop from around the world.

Photoshop User TV
PUTV is a weekly podcast hosted by Scott Kelby, Dave Cross, and Matt Kloskowski. It usually contains three
tutorials on Photoshop or related Adobe software as well as news about events or classes. Previous names have been
Photoshop TV and briefly NAPP TV. Since the start of spring 2008, they are now airing on live tv at Fox Business
Channel.

External links
• NAPP Website [1]

• Photoshop User TV [2]
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SVG Kit for Adobe Creative Suite

Developer(s)  Scand Ltd.

Stable release  2010 (1.0.0) / May 21, 2010

Written in Java, C++, objective C++

Operating
system

Microsoft Windows, Mac OS
X

Type Plug-in

License Shareware

Website svg.scand.com [1]

SVG Kit for Adobe Creative Suite is a plug-in, which adds full-functional support of SVG [2] images to Adobe
InDesign and Adobe Photoshop. Because of the fact, that Adobe's SVG support is limited (the most up-to-date
version of Adobe Creative Suite at a current point in time is CS5), it is possible to work with SVG directly only in
Adobe Illustrator. To avoid quality losses and edit vector graphics in InDesign or Photoshop, the only alternative is
to convert SVG image to EPS vector format first. SVG Kit gives opportunity to work with SVG like with any other
supported type, which makes it efficient for design and desktop publishing purposes, when usage of numerous vector
image files is assumed.
SVG Kit for Adobe Creative Suite is based on Apache Batik [3] 1.7 with custom patches.

SVG Kit for Adobe InDesign features.
• All InDesign graphics editing commands and options are supported.
• All the effects are applied to SVG image content (text, figures, etc.) instead of image bounding box.
• Adobe InDesign Server is supported (Windows only), so it is possible to use SVG images in automated printing

process in the same manner as EPS and other ones.
• SVG images 1.0, 1.1 and 1.2 specification support.
• Correct support of PDF flattening, RGB and CMYK color spaces and SVG export to EPS as a vector image. No

menus are added - everything is integrated into existing commands, like “Place” and “Export”.
• Ability to export SVG to ePub documents and Adobe Dreamweaver projects.

SVG Kit for Adobe Photoshop features.
• Advanced conversion from SVG to PSD: image will be disassembled automatically, depending on SVG figures,

opacity and effects. All intercepted polygons will be moved to different layers, for further image editing.
• Transparency effect is realized in specific way: if possible, it is applied not to the raster object itself, but to the

whole layer.

Supported OS and Adobe Creative Suite software.
• for Mac OS X: MacOS X 32 and 64 bit, Creative Suite CS4 / CS5
• for Windows:

• for Windows 32 and 64 bit, Creative Suite CS3, CS4 and CS5 32bit
• for Windows 32 and 64 bit, Adobe InDesign Server 32 bit CS3 and CS4
• for Windows 64 bit, Adobe InDesign Server 64 bit CS4 or CS5, Adobe Photoshop 64 bit CS4 or CS5

There are also installation packages without Java machine, for those systems, with Java machine installed.
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See also
• List of vector graphics editors
• List of desktop publishing software

External links
• SVG Kit homesite [1]

• SVG clipart under a Creative Commons license [4]

References
[1] http:/ / svg. scand. com
[2] http:/ / www. w3. org/ Graphics/ SVG/
[3] http:/ / xmlgraphics. apache. org/ batik/
[4] http:/ / openclipart. org/
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Article Sources and Contributors
Adobe Photoshop  Source: http://en.wikipedia.org/w/index.php?oldid=374769867  Contributors: -Majestic-, 122589423KM, 16@r, 194.109.232.xxx, 5ko, A.t.bruland, A3RO, A:-)Brunuś,
ARUNKUMAR P.R, ASPimages, AVRS, Aaarrrggh, Aanhorn, Aapo Laitinen, Aavindraa, AbsolutDan, Academic Challenger, Acb, Acidburn24m, Adamnelson, Adi4094, AdjustShift,
Adoniscik, Adrie7, Aeons, Aerielle 7@yahoo.com, Agateller, Ahoerstemeier, Aido2002, Airplaneman, Aitias, Aj00200, Alansohn, Ale jrb, Alegrismith, Alejo2083, Alex Spade, AlexPlank,
Alexander VII, Alexandru.rosu, Alfio, Ali@gwc.org.uk, Alihayyo, AlistairMcMillan, Allstarecho, Alrofaee, Althepal, Alton, Ameliorate!, Anakata, Anas Salloum, Andrew c, Andrewmc123,
Andrewpmk, Andymarczak, Angelic Wraith, Angrykeyboarder, Antandrus, Antarctic-adventurer, Anton Khorev, AnyPerson, Apeiron, Applemeister, Arpingstone, Artaxiad, Arthur Rubin,
Artisol2345, Asbestos, Asenine, Ashdurbat, Asparagus, Astral, Asydwaters, Atif.t2, Atlant, Audriusa, Auricfuzz, Avillia, Avono, BCube, Baalsinyourmouth, Backslash Forwardslash, Badgernet,
Badmash007, Barbi6, Barry Pearson, Barrylb, Bart133, Barts1a, Bass fishing physicist, Bbh123, Benjamin9003, Beringar, Bernardd, Bill37212, Blah0401, Blanchardb, Blueforce4116,
Bluerasberry, Blueshade, Boatman, Bobo192, Bonadea, Borbrav, Borgx, Brandalone, Brandon5485, Brightc, Brodalco, Brownsteve, Bumnut, Burgundavia, Bvlax2005, C4PL1N, CNET nt,
COMPFUNK2, CTZMSC3, Cacophony, Caesura, CalebNoble, Caltas, CambridgeBayWeather, Camw, Canthusus, Captain panda, Carewolf, CarolSpears, Catgut, Cclloyd9785,
Ccox@adobe.com, Ceas webmaster, CecilWard, Changezi, Chaos Blader, Chocolateboy, Christian75, Ckatz, Clasqm, Clcrazy4horses, CliffC, Clpo13, Cmglee, Coffeezombie, Connormah,
Conversion script, CoolingGibbon, Corey911, Courcelles, Cpl Syx, Credema, Cremepuff222, Crispy1083, Crocadillion, Crossmr, Crowd2007, Crt, Csabo, Csmaster, Ctk198, Ctlemonade, Curtis
Newton, CyberSkull, Cynical, DONNYness, DVD R W, Damaster98, Damian Yerrick, DancingPenguin, DanielEng, Danieljackson, Darknub, Darkstreet21, Dashiel, Datoad, Dave souza,
Daverose31, Daveyjones182, David Gerard, DavidWBrooks, DayToDie, Dcljr, Dcoetzee, DeadEyeArrow, Dearsina, Deeahbz, Dekisugi, Delldot, Demi, Dendodge, Denisutku, DerHexer,
Devourer09, Dfrg.msc, Dgies, Dicklyon, DieBuche, Diego pmc, Dikuno, Dingemansm, Discospinster, Djk3, DocWatson42, Dogcow, Donfbreed, Doodle 69, Doover, Doradus, Dorin nicolaescu,
Dougweller, Doulos Christos, Dp462090, Dpol, DreamGuy, Ds.mt, Dudecakes, Dunnob, Duy Huu Nguyen, Dylan anglada, EOZyo, ESkog, EXERO, EagleOne, Ed g2s, Edcolins, Edward,
Eflouret, Egmontaz, EhJJ, ElKevbo, ElectricRay, Ellmist, Elsendero, EmpMac, Energetic is francine@yahoo.com, Energy Dome, Epbr123, Epidemic33, Esanchez7587, Esasus, Escape Orbit,
Esperant, Eugeni, Excirial, Eyckzo, F Zero QQQ GX, F-kun, FDRTools, Fa2f, Fallacious Demeanor, Fatcowms, Fdp, Fennec, Feydey, Firdaus065, FirstPrinciples, FleetCommand, Floaterfluss,
Flying Oaf, Fox, Fragbase, Free Bear, Free Software Knight, Fudoreaper, Fumitol, Furrykef, Fvw, Fyngyrz, Fyyer, GB fan, Gagandeep, Gameguider, Garibaldi84, Gary King, Gary56, Ged UK,
GeoffPurchase, GeorgeMoney, Gerbrant, Get It, Giant Blue Anteater, Giggy, Gioto, Gnepets, Goatasaur, Gogo Dodo, Goldbanjo, Goodvac, GraemeL, Grayshi, Grayson, Gronky, Gscshoyru,
Gurch, GuruMeditation, Gutza, Guyjohnston, Gwernol, Haakon, Hadal, Haeleth, HalfShadow, Happenstance, Harmil, Harryboyles, Headinthedoor, Hebrides, Hede2000, Hedwig0407,
Heeler1996, Henry Flower, Henry W. Schmitt, HereToHelp, HerrSchnapps, Hgrobe, Hikaru79, Hippy deluxe, Hmains, Hraefen, Huaiwei, Huangcjz, HumphreyW, HybridShadow, Hypo, I am an
Apple Head, IFaqeer, IPSOS, IPlayTS3, Iamgmm, Ian Rubin, Icairns, Illegal Operation, Ilyag, Imorgan, Imran4274, Imroy, Inferno, Lord of Penguins, Infinity0, Infodriveway, Insanity Incarnate,
Intersol, Iridescent, Irrawaddy, Isilanes, It Is Me Here, Ivan sus77, JForget, JMabry, Jackjeff, Jackol, Jacobolus, JadedVII, Jake Wartenberg, Jake Wasdin, Jakg, JamesBWatson, JamesRandom,
Jamesontai, Jamesrskemp, Jan Hofmann, Janadore, Janke, Jarash, JasonDeLima, JavierMC, Jedijames, Jeevanus, JenHarm, Jennica, JenniferHeartsU, Jerryobject, Jeysaba, Jhdezjr, Jhessela,
JiMidnite, Jimbills1, JimmyBanks6, Jjdon, Jmcollier, Jmelody, JoeSmack, Joelholdsworth, Joffeloff, John Burkov, John254, JohnCD, Johnbrownsbody, Johnnie ong, Johnstell, Jojon8, Jon
Ascton, Jonik, Jonnyrice1, Jordash, Joshua Issac, Jtkiefer, Junixrose, Jusdafax, KFP, KSI GuNmAn203, Kanyt701201, Katalaveno, Keilana, Kevin B12, Keyser Söze, Kgagne, Khaosaming,
Kiand, Kieff, King of Hearts, Kitkatkelly, Klausness, KnowledgeOfSelf, KortKramer, Kraetos, Krawi, Kreeningsons, Kungming2, Kurainosaru, Kuru, Kyle Schmidt, L Kensington, LLarson,
Lame Name, Larry V, Lcaa9, Leif, LeilaniLad, Lenary, Les boys, LiDaobing, Lightmouse, Lights, Limulus, Lionshuja, Little Professor, Llort, Loganskie, LogiNevermore, Logixoul,
LongGoneVista, LordBleen, LouScheffer, Lowellian, Luckas Blade, Ludde23, Luk, Luna Santin, Lupin, M4gnum0n, MBK004, MER-C, MIckStephenson, MacGeekDC, Macaddct1984, Mad78,
Maelnuneb, Magicretouch, Magnus Manske, MalkyMac, MamboJambo, Mandarax, Marak24, Martarius, MartinDK, Martpol, Masoodrizvi16, Master of Puppets, Mattg82, Mattgirling,
Matticus78, Mauro Bieg, Max0550, Maximus Rex, Mazin07, McSly, MechMykl, Mechamind90, Medovina, MegaZega93, Mentifisto, Meow, Metaprimer, MetsFan76, Meyermagic, Michael
Hardy, Mickey oh ya, Midgrid, Midway, Mighty Racoon, Mike Payne, Mikey-San, Mindmatrix, Minghong, MiracleMat, MisterTee, Mizushimo, Mjb, Mlewan, Mms, Mmxx, Mocoloco311,
ModusOperandi, Mohamed Magdy, Monkeyman, Moonriddengirl, Mormegil, Morn, Moss1234, Motoxguy47, Mpcalan, Mpower256, Mr.bonus, MrOllie, Mrinal Mohit, Mrs.timberlake, Mschel,
Msikma, Msr69er, Muhaidib, Mwanner, MyNameIsNotBob, Myopica, Myscrnnm, Mysidia, N n, NHJG, NUI-Industries, Nagy, Naruelle, Natelovesjessi, Navstar, Ndenison, Neckro, Ned Scott,
Neilsp8, Neon white, NerdyScienceDude, Netsnipe, Neverquick, Nicholo008, Nick1915, Nicolas1981, Nicrok, Nifky?, Nightscream, Nihiltres, NikolaCullen95, Nitya Dharma, Nivix, Njj5546,
Nn123645, Noodle snacks, Notinasnaid, Nrcprm2026, Nxxus, Nyttend, Obli, Od Mishehu, Odie5533, Ohnoitsjamie, Okgrafix, Omicronpersei8, OnePt618, Onebravemonkey, Oneiros, Onorem,
Optakeover, Oscarthecat, Oxydo, Oxymoron83, Ozguy89, PAR, PGSONIC, PHDrillSergeant, Pac72, Pamri, Panchurret, Paper Luigi, Passitivity, Patrick, Paulawallah, Pavilion alex, Pcb21,
Pcpav nz, Pedant, Penmaster, Penubag, Perfecto, Peter G Werner, Pewwer42, Philip Hazelden, Philip Trueman, Phlops, Photoshop tutorials, Piano non troppo, Pinkadelica, Pip11, Pittbull187,
Plasticup, Plop, Poiuyt Man, Polarlys, PopeMickJagger, Porges, Pradeepkoundal, Prari, Precious Roy, Preslethe, Priceyg, Prisonblues, Pro66, Professorshinobi, Protohiro, PseudoSudo,
Psychonaut, Quamaretto, Que.S.H, Quebec99, Quintote, Qutezuce, RSStockdale, RUL3R, Rad Racer, Radon210, Ragib, RainbowOfLight, Rainchill, Rasbelin, Rdsmith4, Red Alien, RedCoat10,
Redfarmer, Redvers, Reisio, Remember the dot, RenniePet, Repetition, Rexibit, Rgoodermote, Rhobite, Rick Sidwell, Rightleftright, Risk one, Rita Moritan, Rjwilmsi, Rl, Rob.derosa, Robbh66,
RockMFR, Rodneybf, Rogerd, Roketjack, Ronhjones, Rorababy1, Rosant, Rrizzop, Rror, Ryulong, SF007, SFairchild, SMC, SQL, SU Linguist, Safalra, Samwise2007, Sango123, Sanguinity,
Sannse, Saqlain35, Saringer, Sasquatch, Sbfw, Sbisolo, Sbn1984, Scepia, SchfiftyThree, SchuminWeb, Scoo, ScorpSt, Sd card, Sdornan, Seano1, Seansiewkahfai, Seifip, Seinman, Servant Saber,
Sesu Prime, Shadowjams, Shandris, Shanes, SheepNotGoats, Shlomke, Shoehopchicken, Shrish, SidneySM, Silvergoat, Simon123, Sinoue@yahoo.com, Sirkad, Sjledet, Skew-t, Skier Dude,
Skizatch, SkyWalker, Skyezx, Skyfireworks, Skylercall, Slakr, Slayerx675, Slgworks, Slowbrow, Smack, Smashanator, Smile a While, Smocking, Smyth, Snowolf, Softwarehistorian,
Someguy1221, Somthinofpie, Sotomura, Souphanousinphone, Spellmaster, SpuriousQ, Squib, StarWarsDude2007, Steeev, Sten10, Stephenchou0722, Stephentwest, Stepshep, Stevenrasnick,
Stewartadcock, Stib, Stirling Newberry, Stratford490, Streetjo, Stuartyeates, Sunny G, Suruena, Sweetness46, Syahirsyazwan, TERANADON, THEN WHO WAS PHONE?, TJRC, Taggard,
TakingUpSpace, Tarquin, Teapotgeorge, Terjen, TerraFrost, Thatdamncuban, The Emirr, The Evil IP address, The High Fin Sperm Whale, The Thing That Should Not Be, TheDoctor10,
TheKMan, TheTruthiness, Theanthrope, Thebrid, Thedjatclubrock, Thefan7, Thehelpfulone, Themepark, Theotherjackson, Thereen, Theresa knott, ThermoStorm, Theshibboleth, Thingg, Thomas
Gilling, Thumperward, Tide rolls, Tillman, Timotab, Timothy Chavis, Tita-remedios, Tkgd2007, Toby Bartels, Toehead2001, Tofuthegreat, Toussaint, Toxicthree, Toytoy, Tpoole123,
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XTrainCommunity, Xezbeth, Xnikx, Xxovercastxx, Yaninass2, ZX81, Zanimum, Zeerus, Zenohockey, ZeroOne, Zigger, Zondor, Zundark, Zvar, 百家姓之四, 1454 anonymous edits
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